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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider Intermedia and Avaya IP Office 9.1

Intermedia SIP Trunk Service (Intermedia) provides PSTN access via a SIP trunk between the
enterprise and the Intermedia network as an alternative to legacy analog or digital trunks. This
approach generally results in lower cost for the enterprise.

Intermedia is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between Intermedia and Avaya IP Office solution. In the sample configuration, the Avaya
IP Office solution consists of an Avaya IP Office 500v2 Release 9.1, Avaya embedded Voicemail,
Avaya Communicator for Windows (SIP mode), Avaya H.323, Avaya SIP, digital and analog
endpoints.

Intermedia referenced within these Application Notes is designed for business customers. The
service enables local and long distance PSTN calling via standards-based SIP trunks as an alternative
to legacy analog or digital trunks, without the need for additional TDM enterprise gateways and the
associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office and
connecting to Intermedia.

This configuration (shown in Figure 1) was used to exercise the features and functionality tests
listed in Section 2.1. Note: NAT devices added between Avaya IP Office and the Intermedia
network should be transparent to SIP signaling.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to Intermedia. To verify SIP
trunking interoperability, following features and functionality were exercised during the
interoperability compliance test:

e Incoming PSTN calls to various phone types. Phone types included Avaya H.323, Avaya
SIP, digital, and analog telephones at the enterprise. All inbound PSTN calls were routed to
the enterprise across the SIP trunk from the service provider.

e QOutgoing PSTN calls from various phone types. Phone types included Avaya H.323, Avaya
SIP, digital, and analog telephones at the enterprise. All outbound PSTN calls were routed
from the enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls from/to the Avaya Communicator for Windows (SIP
mode).

e Inbound and outbound long hold time call stability.

e Various call types including: local, long distance, international call, outbound toll-free, 411
Directory Assistant and 911 services.

e Codec G.729A and G.711MU.
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e Caller number/ID presentation.

e Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

e DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

Fax G.711 pass-through.

Off-net call forwarding.

Twinning to mobile phones on inbound calls.

Calls between Avaya IP Office and Intermedia application softphone, Intermedia sends SIP

re-Invite with codecs changed mid-call. These additional test cases are requested by

Intermedia and the system is configured and supported by Intermedia.

Item not supported include the following:

SIP REFER in Call Transfer (transferring calls with the PSTN back to the PSTN).
Diversion Header in Call Redirection.

SIP OPTIONS sent by Intermedia.

Outbound calls to Operator Assisted Call.

Faxing using T.38.

2.2. Test Results

Interoperability testing of Intermedia was completed with successful results for all test cases with the
exception of following limitations:

e Blind Call Transfer to PSTN using Avaya 1140E SIP phone did not complete until
transferee picked up the call - PSTN phone called to Avaya 1140E SIP phone, then Avaya
1140E SIP phone answered the call and performed blind transfer to another PSTN endpoint.
The expected behavior of Avaya 1140E SIP phone is after the transfer is completed, the
phone should display “transfer completed”. But in this case, after user pressed “transfer”
button and answered question of “Consultative transfer with party ?”” with “No”, which
implied the blind transfer, the transferee PSTN phone rang and the Avaya 1140E SIP phone
was still displayed “transferring” until the transferee PSTN phone answered the call. The
work around was to hang up the Avaya 1140E SIP phone. This is a known limitation on
Avaya 1140E SIP phone. There is no user impact. Transfer is still completed with two-way
audio.

e Intermedia did not respond correctly with the outbound calls using the mismatch
codecs between Avaya and Intermedia — Avaya sent SIP Invite with codec G723 only, but
Intermedia still replied 183 SDP with G729 instead of sending "488 Not Acceptable here".
This issue will be fixed in future release by Intermedia. Intermedia will need to work with
customers to make sure they use correct supported codecs.

¢ Intermedia did not change the URI in TO and FROM headers of SIP INVITE for
inbound calls accordingly - The Intermedia SBC was implemented with SIP Gateways and
SIP Proxies. When the SIP Gateway was generating the SIP INVITE, it used its internal IPs
and Ports instead of using IPs and Ports of public interfaces between Intermedia SBC and
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Avaya IP Office. The SIP Proxy was not allowed to change the FROM/TO headers
information. Avaya IP Office ignores these IPs and Ports in the URI of TO and FROM
headers.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit:
http://support.avaya.com

For technical support on the Intermedia, please contact customer service at 1-800-379-7729 or visit:
http://www.intermedia.net/products/sip-trunking

3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to Intermedia through the public IP network. For confidentiality and privacy purposes,
actual public IP addresses used in this testing have been masked out and replaced with fictitious IP
addresses throughout the document.

The Avaya components used to create the simulated customer site including:
Avaya IP Office 500v2

Avaya embedded Voicemail for IP Office

Avaya 9600 Series IP Deskphones (H.323)

Avaya 11x0 Series IP Deskphones (SIP)

Avaya 1408 Digital phones

Avaya Analog phones

Avaya Communicator for Windows (SIP)

Located at the enterprise site is an Avaya IP Office 500v2 with the MOD DGTL STA16 expansion
module which provides connections for 16 digital stations to the PSTN, and the extension PHONE 8
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(\Voice Compression Module) for supporting VVolP codecs. The voicemail service is embedded on
Avaya IP Office. The LAN2 port of Avaya IP Office is connected to the public IP network. A
separate Windows XP PC runs Avaya IP Office Manager to configure and administer Avaya IP
Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user’s
phones will also ring and can be answered at configured mobile phones.

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 4 0of 31
SPOC 5/18/2015 ©2015 Avaya Inc. All Rights Reserved. IM_IPO91


http://support.avaya.com/
http://www.intermedia.net/products/sip-trunking

( 10.10.97.X 0

3 / /
Avaya IP Office 500 V2

Release 9.1
Embedded Voicemail 10 4 . -

Avaya 9600 Avaya 1140E
Series Ip IP Deskphone

Deskphones (SIP) 1P Office
(H.323) Manager
Avaya
- Communicator
Analog FAX Digital for Windows
Phone Phone (SIP)
1
( 10.10.98.X 0

DevConnect Test LAB

Enterprise site

Service Provider

Intermedia Session Border Controller

Internet

Intermedia
Network

Signaling Server IP address:
192.168.122.44

-

4 ;

¥ Mobile  pigital Phone
twining Fax
with Cell

Figure 1: Test Configuration for Avaya IP Office with Intermedia SIP Trunk Service

For the purposes of the compliance test, Avaya IP Office users dialed a short code of 9 + N digits to
send digits across the SIP trunk to Intermedia. The short code of 9 was stripped off by Avaya IP
Office but the remaining N digits were sent unaltered to Intermedia. For calls within the North
American Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus, for these NANP
calls, Avaya IP Office would send 11 digits in the Request URI and the To header of an outbound
SIP INVITE request. It was configured to send 10 digits in the From field. For inbound calls,
Intermedia sent 10 digits in the Request URI and the To header of an inbound SIP INVITE request.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and Avaya IP Office, such as, a session border controller
or a data firewall. A complete discussion of the configuration of these devices is beyond the scope of
these Application Notes. However, it should be noted that SIP and RTP traffic between the service
provider and Avaya IP Office must be allowed to pass through these devices.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment Release
Avaya IP Office 500v2 9.1.0.0 Build437
Avaya IP Office DIG DCP*16 V2 9.1.0.0 Build437
Avaya IP Office PHONES 9.1.0.0 Build437
Avaya IP Office Manager 9.1.0.0 Build437
Avaya 1140E SIP 04.04.18.00
Avaya IP 9640G S3.2
Avaya IP 9630 S3.2
Avaya Communicator for Windows (SIP) 2.0.3.30
Avaya Digital Telephone (1408D) N/A
Avaya Symphony 2000 Analog Telephone N/A
HP Officejet 4500 (fax) N/A

Intermedia Components
Equipment Release

Intermedia Session Border Controller

16.8.4

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with all configurations of IP Office Server Edition without

T.38 Fax Service.
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5. Configure Avaya IP Office

This section describes the Avaya IP Office configuration to support connectivity to Intermedia.
Avaya IP Office is configured through the Avaya IP Office Manager PC application. From a PC
running the Avaya IP Office Manager application, select Start - Programs - IP Office >
Manager to launch the application. Navigate to File > Open Configuration, select the proper
Avaya IP Office system from the pop-up window, and log in using appropriate credentials. A
management window will appear similar to the one shown in the next section. The appearance of the
IP Office Manager can be customized using the View menu. In the screens presented in this section,
the View menu was configured to show the Navigation Pane on the left side, the Group Pane in the
center, and the Details Pane on the right side. These panes will be referenced throughout Avaya IP
Office configuration. Proper licensing as well as standard feature configurations that are not directly
related to the interface with the service provider (such as the LAN interface to the enterprise site and
Avaya Communicator for Windows) is assumed to be already in place.

5.1. LAN2 Settings

In the sample configuration, the IPOffice_1 was used as the system name and LAN2 port was used
to connect to Intermedia. To access LAN2 settings, first navigate to IPOffice_1 - System (1) in the
Navigation and Group Panes and then navigate to the LAN2 - LAN Settings tab in the Details
Pane. Set the IP Address field to the IP address assigned to the Avaya IP Office LAN port. Set the
IP Mask field to the mask used on the public network. All other parameters should be set according
to customer requirements. Click OK to submit the change.

=
IP Offices System ’ 7 POffice_1" v

ds e AAME | LAND| DN | Yocemel | Telepheny | Diectery Senes | Syiem Everts | SMTP | SMOR  Towswnsng | VOM | Codecs | Vel Secuerty | Comtast Comter
LAt Settings| yuB | Netwes Tepdogy

P Addrenz bl ) 2

ki\"‘?f_ll@ )GGrERa™s

The VolIP tab as shown in the screenshot below was configured with following settings.

e Check the H323 Gatekeeper Enable to allow Avaya IP Deskphones/Softphones using the
H.323 protocol to register.

e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to
Intermedia.

e Check the SIP Registrar Enable to allow Avaya IP Deskphones/Softphones to register using
the SIP protocol.

e Input Domain Name as 10.10.98.14, which should be same as configured for LAN2 earlier
in this section.

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 70of31
SPOC 5/18/2015 ©2015 Avaya Inc. All Rights Reserved. IM_IPO91




e The Layer 4 Protocol use UDP with UDP Port as 6060, and TLS with TLS Port as 5061.

e Verify the RTP Port Number Range settings for a specific range for the RTP traffic. The
Port Range (Minimum) and Port Range (Maximum) values were kept as default.

o Verify the DiffServ Settings were kept as default for the Differentiated Services Code Point
(DSCP) parameters in the IP packet headers to support Quality of Services policies for both
signaling and media, the DSCP field is the value used for media and the SIG DSCP is the
value used for signaling.

e All other parameters should be set according to customer requirements.

e Click OK to submit the changes.

7 IPOffice_1* ¢ v

{‘System] LANL } - .’DNS ] Voicemail ] Telephony I Directory Services I‘System Events [ SMTP [ SMDR [TwinningA]AVCM AIACodecs IFVOIP Security> ‘Contact Center.‘r

iLZNisgtmigsi ‘VNetwo;k Topology}
[[@] H323 Gatekeeper Enable|
] Auto-create Extn Auto-create User [] H323 Remote Extn Enable

1720

[¥] SIP Trunks Enable
[V] SIP Registrar Enable

Auto-create Extn/User [7] SIP Remote Extn Enable
Domain Name 10.10.98.14
[¥] upp UDP Port 6060 = ote UE 5060
Layer 4 Protocol [C] Tcp TCP Port 5060 : 5060 .
@] TLS TLSPort 5061 = . 5061
Challenge Expiry Time (secs) 10
RTP
Port Number Range
Minimum 49152 S Maximum 53246
Port Number Range (NAT)
Minimum 49152 = Maximum 53246 =

[] Enable RTCP Menitoring on Port 5005

RTCP collector IP address for phones 0 0 0 0

Keepalives
Scope [Disabled ~| 20
Enabled

DiffServ Settings

B8 + DSCP(Hex) B8 % Video DSCP(Hex) |FC % DSCP Mask (Hex) 88 < SIG DSCP (Hex)

46 | Dscp 46 | Video DSCP 63 | DSCP Mask 34 5| SIG DSCP

“ OK ]II Cancel H Help
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set the Binding Refresh Time (seconds) to 30. This value is used as one input to determine
the frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider.

e Set Public IP Address to the IP address of the Avaya IP Office LAN2 port.

e Set Public Port for UDP as 6060, and TLS as 5061.

e All other parameters should be set according to customer requirements.

e Click OK to submit the changes.

7 IPOffice_1* & v

I System [ LANL 7 HDNS ] Voicemail I Telephony l Directory Services | System Events l SMTP l SMDR [ Twinning I VCM ] Codecs | VoIP Security | Contact Center} )
LN stinge Vob_| [vorcTepioy|

Network Topology Discovery

STUN Server Address 192168.10.13 STUN Port 3478

Firewall/NAT Type [Open Internet >, 1

Binding Refresh Time (seconds) 30

Public IP Address 10 10 98 14 \ Run STUN Cancel

Public Port
UDP 6060

TCP 5060

TLS 5061

\"| Run STUN on startup

I 0K H Cancel H Help J

In the compliance test, the LANL1 interface was used to connect the Avaya IP Office to the enterprise
site IP network. The LANL1 interface configuration is not directly relevant to the interface with
Intermedia, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings

Navigate to IPOffice_1 - System (1) in the Navigation and Group Panes (not shown) and then
navigate to the Telephony - Telephony tab in the Details Pane. Choose the Companding Law
typical for the enterprise location. For North America, U-Law is used. Uncheck the Inhibit Off-
Switch Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the
service provider across the SIP trunk. Set Hold Timeout (secs) to 1200. Click OK to submit the
changes.

= IPOffice_1* % | &

1 System [ LANL [ LAN2 [ DNS ] Voicemail? Telephony| —l Directory Services ] System Events ] SMTP I SMDR I Twinning I VCM [ Codecs] VolP Security | Contact Center

|[Telephony] | park & Page | Tones & Music| Ring Tones [ M | calltog [ TUI |

Analogue Extensions Companding Law ‘:
Switch Line
Default Outside Call Sequence [Norma! V]
Default Inside Call Sequence [Ring Typel V] IM
Default Ring Back Sequence {Ring Type2 VI
) . . = ) A-Law ) A-Law Line
Restrict Analogue Extension Ringer Voltage =
=
Dial Delay Time (secs) 4 B35 Status
[¥] Auto Hold
Dial Delay Count 0 AT
5 Dial By Name
Default No Answer Time (secs) 15
[¥] Show Account Code
Hold Timeout (secs) 1200 = s
[7] Inhibit Off-Switch Forward/Transfer
Park Timeout (secs) 300
g [ Restrict Network Interconnect

Ring Delay (secs)
Include location specific information

Call Priority Promotion Time (secs) |Disabled

m

[] Drop External Only Impromptu Conference

Default Currency uUsb > :
|| Visually Differentiate External Call

Default Name Priority ,

[ Unsupervised Analog Trunk Disconnect Handling

Media Connection Preservation Disabled v
|¥| High Quality Conferencing
Phone Failback Manual v =
|| Digital/Analogue Auto Create User

Login Code Complexity -
|| Directory Overrides Barring

[7] Enforcement
Complexity
[ oK l [ Cancel ] [ Help
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5.3. System Codec Settings

Navigate to IPOffice_1 - System (1) in the Navigation and Group Panes (not shown) and then
navigate to the Codecs tab in the Details Pane. Choose the RFC2833 Default Payload as IP Office
default of 101. Select codecs G.729(a) 8K CS-ACELP, and G.711 ULAW 64K that Intermedia
supports. Click OK to submit the changes.

i= IPOffice_1 i v
i System I LAN1 I LAN2 l DNS 1 Voicemail ] Telephony [ Directory Services I System Events l SMTP I SMDR | Twinning I VCM | [Codecs !VoIP Security | Contact Centeri
‘RFC2833 Default Payload 101 > ‘
Available Codecs Default Codec Selection
Unused Selected
[@] G711 ULAW 62t G6.723.1 6K3 MP-MLQ G.729(z) 8K CS-ACELP
(V] G.711 ALAW 64} G.711 ALAW 64K G.711 ULAW 64K
| G.722 64K

[V 6.729(a) 8K CS-ACELP
[V 67231 6K3 MP-MLQ

| OK l[ Cancel H Help
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5.4. Twinning Calling Party Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two
parameters. These parameters only affect twinning and do not impact the messaging or operation of
other redirected calls such as forwarded calls. The first parameter is the Send original calling party
information for Mobile Twinning box on the Twinning tab, as shown below. The second
parameter is the Send Caller 1D parameter on the SIP Line form (shown in Section 5.5.2).

If Send original calling party information for Mobile Twinning on the Twinning tab is checked,
the setting of the second parameter is ignored and Avaya IP Office will send the following in the SIP
From Header:
e On calls from an internal extension to a twinned phone, Avaya IP Office will send the calling
party number of the originating extension.
e On calls from the PSTN to a twinned phone, Avaya IP Office will send the calling party
number of the host phone associated with the twinned destination (instead of the number of
the originating caller).

If this option is unchecked, the value sent in the SIP From header is determined by the setting of the
second parameter mentioned above.

e For the compliance test, the Send original calling party information for Mobile Twinning
box in the IPOffice_1 = System (1) - Twinning tab was unchecked. The value sent in the
SIP From header is determined by the setting of the Send Caller 1D parameter on the SIP
Line form.

= IPOffice_1 i v

}”S;stem I LAN1 I LANZ IDNS I VVc;ircemarilr %élep}hony i bi;edory 7Serr\.rlirces IVSVystemrErvents iSMT;’ |SMDR VCM IVCoare:s l \710717P”Secu}irty iréontact VCVenter‘;

| Send original calling party information for Mobile Twinning I

Calling party information for
Mobile Twinning
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5.5. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and Intermedia SIP
Trunk service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.5.1 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP Credentials (if applicable).

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.5.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.
e SIP Advanced Engineering.

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation Pane
and select New = SIP Line. Then, follow the steps outlined in Section 5.5.2.
For the compliance test, SIP Line 17 was used as trunks for incoming and outgoing calls.
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5.5.1. Create SIP Line from Template.
1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to AF_Intermedia_SIPTrunk.xml (for SIP Line 17). The file name is
important in locating the proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File 2 Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the box is checked next to Enable Template
Options. Click OK to submit the changes.

™ IP Office Manager Preferences l 2 I&J
i Preferences I Directories ] Discovery J [Vi5U3| Preferencesl j Security I Validation‘
! Icon Size ‘Small vl

7] Multiline Tabs

l (/| Enable Template Optionsl

[¥| Enable Template Creation

(1) ‘ oK l ! Cancel I l Help

3. Import the template into IP Office Manager. From IP Office Manager, select Tools -
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

' Asaya P Ofice Manoger IPOMCe T 75 1OAIT] drvenistmondminsmaor] =
Fie B Yeew Tocts|| Hep
» |
‘ | E sPlsenen CEEICIAR
Expart :"" SubTrpe: | oo Lane Trnsgpon| 5 LI VoiP | 3% Ter 9P Credontive| SP Advinced | Engloesing
SO Sevsce Uses Managasent :
By an Hewd Valdoion
MSH Cosfigusntion |
Impert Tamrpristen in Manages
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In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window
below will appear stating success (or failure). Then click OK to continue. If preferred, this
step may be skipped if the template file is copied directly to the IP Office template directory.

Template Provisioning

]

. ‘| Successfully imported templates to IP Office Manager from
WY ClintermedialPO%1\Template

| ok |

4. To create the SIP Trunk from

the template, right-click on Line in the Navigation Pane, then

navigate to New SIP Trunk from Template.

IEG (&0 9™

PN D =
f C M

96 Line-Line 2

e Trammpent | S0 USRI WP | 738 Fas R C 5V Advanced Enge

5.

In the subsequent Template Type Selection pop-up window, check Display All and select

AF_Intermedia_SIPTrunk from the Service Provider pull-down menu as shown below.
These values correspond to parts of the file name (AF_Intermedia_SIPTrunk.xml) created
in Step 1. Click Create new SIP Trunk to finish creating the SIP trunk.

™ Template Type Selection =1 Lﬁ

nited

Locale U

States (LIS b

nalich)

1aqNsn

Service Provider

AF_Intermedia_SIP Trunk

«||[@] Display Al |

l Create new SIP Trunk l Cancel ’

6. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration

shown in Section 5.5.2.
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5.5.2. Create SIP Line Manually
To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the

Group Pane and select New - SIP Line (not shown).
On the SIP Line tab in the Details Pane, configure the parameters as shown below:

Set ITSP Domain Name to the IP address of Avaya IP Office LANZ2 port.

Check the In Service and Check OOS boxes.

Set URI Type to SIP.

For Session Timers, set Refresh Method to Reinvite with Timer (seconds): 1200.

For Forwarding and Twinning, set Send Caller ID to None.

For Redirect and Transfer, set Incoming Supervised REFER and Outgoing Supervised
REFER to Never. Note: Intermedia did not support the REFER for compliance testing.
Default values may be used for all other parameters.

e Click OK to commit then press Ctrl + S to save.

1P Offices | Line E SIP Lina - Line 17° ¥ oE X v
& oor o S oy 5 Lne| Traspert | GP U VelF | 733 Foe P Conshentiots| 59 Advanced Engisenring
‘ 8 2 : 'A:Lr 1 7
- P Lne TSP Dorsun Naeny 0105614
< UPE Type > = Sesson Tiowr
‘a L : Methad e "
=~ - ndz) i
@
2 Nec unbe
9‘ btemec i send Caller D Nowe
- >
o Acc . edrect and Tiam!
-l wemog S ever »
« N steyn Dietalt ~
‘l n3n - -
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On the Transport tab in the Details Pane, configure the parameters as shown below:

e The ITSP Proxy Address was set to the IP Address of Intermedia signaling server
192.168.122.44 as shown in Figure 1.

¢ Inthe Network Configuration area, UDP was selected as the Layer 4 Protocol and the Send
Port was set to 6060 which is the port number supported by Intermedia.

e The Use Network Topology Info parameter was set to LAN 2. This associates the SIP Line 17
with the parameters in the System (1) > LANZ2 - Network Topology tab. The Listen Port
was set to 6060 which is the port number supported by Intermedia.

e The Calls Route via Registrar was unchecked. In this certification testing, Intermedia did not
support the dynamic Registration on the SIP Trunk.

e Other parameters retain default values.

e Click OK to commit then press Ctrl + S to save.

7 SIP Line - Line 17 ek - X| v <]

sIP Linei‘iSIP URIIVOIP |T38 Fax! SIP CredentialslSIP Advanced]Engineering}

‘ ITSP Proxy Address 19216812244

Network Configuration

Layer 4 Protocol [UDP v} Send Port 6060
Use Network Topology Info t LAN 2 v ' 6060
Explicit DNS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar l

Separate Registrar

[ ok ||| Cencel |[ Hep
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A SIP Credentials entry must be created for Digest Authentication used by Intermedia SIP trunking
service to authenticate calls from the enterprise to the PSTN. To create a SIP Credentials entry, first
select the SIP Credentials tab. Click the Add button and the New Channel area will appear at the
bottom of the pane (not shown). To edit an existing entry, click an entry in the list at the top, and
click the Edit... button. In the bottom of the screen, the Edit SIP Credentials area will be opened.
In the example screen below, a previously configured entry is edited. The entry was created with the
parameters shown below:

e Set User name/ Authentication Name/ Password/ Confirm Password to the values
provided by the service provider.

e Expiry (mins) is set to 30.

e Check the Registration required option (Intermedia requires registration for Digest
Authentication).

e Click OK to submit the changes.

7 SIP Line - Line 17° gk -8 X[ v <

[SIP Line| Transport| SIP URI|VolP |38 Fax[SIP Credential] SIp Advanced|Engineering

Index UserName Authentication Name Contact Expiry (mins) Register Add...

1 dgwsidXXXXXX  dgwsidXXXXKX 30 True

Remove

Edit SIP Credentials

User name dgwsidXXXXXX ’ oK

Authentication Name dgusidXOCXX @

Contact

Password sssssses

Confirm Password sscesses

Expiry (mins) 30

Registration required @
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A SIP URI entry must be created to match each incoming number that Avaya IP Office will accept
on this line. Select the SIP URI tab; click the Add button and the New Channel area will appear at
the bottom of the pane (not shown). To edit an existing entry, click an entry in the list at the top, and
click Edit... button. In the example screen below, a previously configured entry is edited. For the
compliance test, a single SIP URI entry was created that matched any DID number assigned to an
Avaya IP Office user. The entry was created with the parameters shown below:

e Set Local URI to * to accept any incoming calls. Set Contact, Display Name, and PAI to
Use Internal Data. This setting allows calls on this line whose SIP URI matches the number
set in the SIP tab of any User as shown in Section 5.7.

e Set Registration to 1: dgwsidXXXXXX as Intermedia requires registration.

e Associate this line with an incoming line group in the Incoming Group field and an
outgoing line group in the Outgoing Group field. This line group number will be used in
defining incoming and outgoing call routes for this line. For the compliance test, a new line
group 17 was defined that only contains this line (line 17).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

e Click OK to submit the changes.

7 SIP Line - Line 17* g X | v«

SIP Line| Transport||SIP URT IVoIp |38 Fax|SIP Credentials|SIP Advanced Engineering
|

Channel Groups Via Local URI Contact Display Name PAI Credential Add...
10109814 _* i

1: dgwsidXXX)
Remove

Edit Channel |
Via 101009814

Local URI - = | Concel |

Contact Use Internal Data =

Display Name Use Internal Datal v

PAI Lerna 3 v

Registration |1: dgwsidXXXXX v

Incoming Group 17

Outgoing Group 17

Max Calls per Channel 20
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified. The G.729(a) 8K CS -ACELP,
and G.711 ULAW 64K codecs are selected. Avaya IP Office supports these codecs, which
are sent by the Intermedia, in the Session Description Protocol (SDP) offer, in that order.

e Uncheck the VoIP Silence Suppression box.

e Check the Re-invite Supported box.

e Set Fax Transport Support to T38 Fallback from the pull-down menu. Intermedia supports
Fax fallback to G.711 pass-through mode.

e Setthe DTMF Support to RFC2833 from the pull-down menu. This directs Avaya IP
Office to send DTMF tones using RTP events messages as defined in RFC2833.

e Default values may be used for all other parameters.

e Click OK to submit the changes.

7 SIP Line - Line 17 of -8 (X |vi<|>
EEELine}Transpor;lSIP UEIi ﬁ38 Fa;lSTPCredentials IEIP Advanceidlgngineerinrgj
I\' | VoIP Silence Suppressionl
[¥] Re-invite Supported
Codec Selection [Custom v] [7] Codec Lockdown
Unused Selecteci_A - Allow Direct Media Path
G.723.1 6K3 MP-MLQ S G.729(a) 8K CS-ACELP
G.711 ALAW 64K G.711 ULAW 64K Force direct media with phones
[7] PRACK/100rel Supported
[T] G711 FaxECAN
<L
Fax Transport Support |T38 Fallback -
DTMF Support (RFC2833 -
Media Security ‘Disabled X
[ ok [ cancet |[ Hep
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5.6. Short Code

Define a short code to route outbound traffic on the SIP line to Intermedia. To create a short code,
select Short Code in the left Navigation Pane, then right-click in the Group Pane and select New
(Not shown). On the Short Code tab in the Details Pane, configure the parameters for the new short
code to be created. The screen below shows the details of the previously administered “ON;” short
code used in the test configuration.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 9N;, this short code will be invoked when the user dials 9 followed by
any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N”@192.168.122.44”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The host part following the “@” is the IP address of Intermedia
signaling server.

e Setthe Line Group ID to the Outgoing Group 17 defined on the SIP URI tab on the SIP
Line in Section 5.5.2. This short code will use this line group when placing the outbound
call.

e Setthe Locale to United States (US English).

e Default values may be used for all other parameters.

e Click OK to submit the changes.

1P Offices | Short Code E ~9N;: Diat* el X v o
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The feature of incoming calls from mobility extension to idle-appearance FNE (Feature Name
Extension) is hosted by Avaya IP Office. The Short Code FNEOO was configured with following

parameters:
e For Code field, enter FNE feature code as FNEOQO for dial tone.
e Set Feature to FNE Service.
e Set Telephone Number to 00.
e SetLine Group ID to 0.
e Setthe Locale to United States (US English).
e Default values may be used for other parameters.
e Click OK to submit the changes.

I= FNE0O: FNE Service oo X
Lecale Unaed Sater |US Exgash)
o o bey
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5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.5. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is 5788. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line. The example below
shows the settings for user 5788. The SIP Name and Contact are set to one of the DID numbers
assigned to the enterprise provided by Intermedia. The SIP Display Name (Alias) parameter can
optionally be configured with a descriptive name. If all calls involving this user and a SIP Line
should be considered private, then the Anonymous box may be checked to withhold the user’s
information from the network.

User B 6788: 6788 oA X

OulIn | Vous Kessrdng - Yumen Psgrammeyg | Menu frogramming | Mebisy | Gecup Membershp | Arnsuncenarm ¥ Penensl Drmcrory | Wet 1
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One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User 5788. The Mobility Features and Mobile Twinning boxes
are checked. The Twinned Mobile Number field is configured with the number to dial to reach the
twinned mobile telephone, in this case 91613XXX5205. Check Mobile Call Control to allow
incoming calls from mobility extension to access FNEOO (see Section 5.6). Other options can be set
according to customer requirements.

i 5788: 5788" e - X vl <[5

| DialIn | Voice Recording | Button Programming I Menu Programming | |Mobility ‘ Group Membership | Announcements I SIP l Personal Directory l Wet| ¢« | »

[7] Internal Twinning
<None>
1
1
Twin Bridge Appearances
Twin Coverage Appearances

Twin Line Appearances

[¥] Mobile Twinning

Twinngd quile Number 91613XXX5205
(including dial access code)

Twinning Time Profile <None>

Mobile Dial Delay (secs) 2

Mobile Answer Guard (secs) 0

[] Hunt group calls eligible for mobile twinning
[7] Forwarded calls eligible for mobile twinning
[T] Twin When Logged Out

["] one-X Mobile Client

[¥] Mobile Call Control

[¥] Mobile Callback
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5.8. Incoming Call Route

An Incoming Call Route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by service provider. To create an
incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in the
center Group Pane and select New (Not shown). On the Standard tab of the Details Pane, enter the
parameters as shown below:

e Set the Bearer Capability to Any Voice.

e Setthe Line Group ID to the Incoming Group 17 defined on the SIP URI tab on the SIP
Line in Section 5.5.2.

e Set the Incoming Number to the incoming DID number on which this route should match.

e Default values can be used for all other fields.

17208006788 el X o

3 || Incoming Call Routs ||

hsup K Incoming Number

3

anderd] | Veice Recording | Destinations

Buarer Capabubty Ay Voce -

Live Group B !

$66006

Numthe DE0OSTER

ocale Urvted States O [nghsh) -

TRIIRG ) GGFSRE™S

On the Destination tab, select the destination extension from the pull-down menu of the Destination
field. In this example, incoming calls to 206XXX5788 on line 17 are routed to extension 5788.

1P Offices || Incoming Call Route | - — 17 206XXX5788 - pred X

R 0OOTP & bme Qg B Inceeming Nurriver | | andand | Veice Recording || Destinaticns

- ‘ ﬁ" :.H ” ) _I‘r-.'mr..- Falack xtenpon |
g | {32 57 '( .(
-
ey
e 2081 ®
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For testing purpose, the incoming calls to DID number 206XXX5876 were configured to access
FNEOQO. The Destination was appropriately defined as FNEOO as below screenshot:

1P Offices | Incoming Call Route [-E 17 206XXX6876 et X ¢
0 & Line Gesup £ Incoming Number  Destnstion Skenrd | Viice Recarding | Detimaticns
g: TimeSrotie Destiratron sltack [ tenpon
o o |
! Detactt vabow L F Ty - -

. ey v | 4,( £

: v
& i [ 3
i 28
& &
"™ 5
@ se
& FAS )
@ hcoming Call foutx )
P WA TPos it

For testing purpose, the incoming calls to DID number 206 XXX5876 were also configured to access
VoiceMail. The Destination was appropriately defined as VVoiceMail as below screenshot:

1 Offices | Incoming Call Route = 17 206XXX5676 el X v
R BOOW & Line Gezp K Incoming Numier  Destnstion Skaniard | Visice Recarding || Deitinaticn
e P y .y . hee—
» e b 3 TimeS ot e Destiration sitack [ tengon
[~ 7% b 5245 FANSE4S | \
e Veicesiail | o Detaist vaboe vousidad e =
ok I U 3242 3343
& i £11) S WSS
L TV SI08 5784

g g Call foute ]
WAN Pos 2

i

u

PN Short Code 0
@
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e
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For Inbound Toll-Free testing purpose, any incoming calls to DID number 877XXX8615 were also
configured to route to extension 5788. The Destination was appropriately defined as 5788 as below
screenshot:

Slarndend i Voin Recendmg |Detinaticn

TimwProtle Destinahi o ! otvack tenope

» Detaist Valee 35798 5TH '! -

COrDAR™H

5.9. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. Intermedia SIP Trunk Configuration

Intermedia is responsible for the configuration of Intermedia SIP Trunk Service. The customer must
provide the IP address used to reach the Avaya IP Office at the enterprise. Intermedia will provide
the customer necessary information to configure the SIP connection between Avaya IP Office and
Intermedia. The provided information from Intermedia includes:

IP address and port number used for signaling or media through any security.

e DID numbers.

Authentication username/ password.

Intermedia SIP Trunk Specification.
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7. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start - Programs - IP Office - System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP line of interest from the left

pane. On the Status tab in the right pane, verify that the Current State for each channel

(The below screen shot showed 2 active calls at present time).
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Advwestas Cmgresson

Cristse Pastwswrs

Sherve Scceesser:

Nads Gresn

Lavywr & Profocsc
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Use the Avaya IP Office System Status application to verify that no alarms are active on the
SIP line. Launch the application from Start = Programs - IP Office - System Status on
the PC where Avaya IP Office Manager was installed. Select Alarm - Trunks to verify that
no alarms are active on the SIP line.

[

L inds O

A Cad Gunbiy of S
8 becwrny (8

Lt
Live2
Liem:AT

1S Avays P Office Systen States - FOMCe 1 (I0IN3B1E - F300 V2 3100 bedld 437 [

AVAYA IP Office System Status

Sebect 4 b 10 duplay the alerss information

TN

Verify that a phone connected to the PSTN can successfully place a call to Avaya IP Office
with two-way audio.
Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.
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8. Conclusion

Intermedia passed compliance testing excepting the limitation in Section 2.2. These Application
Notes describe the procedures required to configure the SIP connection between Avaya IP Office
and the Intermedia as shown in Figure 1.
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number 15-601042 Issue 30g, 27 January 2015.

[4] Avaya IP Office™ Platform Embedded Voicemail User Guide (IP Office Mode), Document
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Product documentation for Avaya products may be found at: http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php? XMLFILE=manuals.
XmI&TEMPLATE=pdf feed template.html.

Product documentation for Intermedia SIP Trunking may be found at:
http://www.intermedia.net/products/sip-trunking.

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 30 of 31
SPOC 5/18/2015 ©2015 Avaya Inc. All Rights Reserved. IM_IPO91


http://support.avaya.com/
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php?XMLFILE=manuals.xml&TEMPLATE=pdf_feed_template.html
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php?XMLFILE=manuals.xml&TEMPLATE=pdf_feed_template.html
http://www.intermedia.net/products/sip-trunking

©2015 Avaya Inc. All Rights Reserved.

Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and ™
are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the
property of their respective owners. The information provided in these Application Notes is
subject to change without notice. The configurations, technical data, and recommendations
provided in these Application Notes are believed to be accurate and dependable, but are
presented without express or implied warranty. Users are responsible for their application of any
products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 31 0f 31
SPOC 5/18/2015 ©2015 Avaya Inc. All Rights Reserved. IM_IPO91



